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Turbo C++ is a powerful compiler for beginner and experienced
C++ and C programmers. With Turbo C++, you get both C++
(AT&T v:2.1 compliant) and ANSI C. It is a powerful, fast, and effi-
cient compiler for creating practically any application.

C-++ is an object-oriented programming (OOP) language that
allows you to take advantage of OOP’s advanced design
methodology and labor-saving features. It's the next step in the
natural evolution of C. C++ application programs are portable, so
you can easily transfer them from one system to another. C++ is
suitable for almost any programming task.

What’s in Turbo C++

Chapter 1 tells you how to
“install Turbo C++. This
Infroduction tells you where
you can find out more about
each of these features.

Infroduction

Turbo C++ includes the latest features programmers have asked
for:

m C and C++: Turbo C++ offers you the full power of C and C++
programming, with a complete implementation of the AT&T v.
2.1 and ANSI C specifications. Turbo C++ 3.0 also provides a
number of useful C++ class libraries, plus the first complete
commercial implementation of templates. With templates,
efficient collection classes can be built using parameterized

types.

= Faster compilation speed: Typically, Turbo C++ 3.0 cuts
compilation time for C++ in half compared to previous versions
of the product. Precompiled headers, a Borland exclusive,
significantly shorten recompilation time.

‘m DPMI Compiler: Turbo C++ compiles huge programs of a size

limited only by the memory on your system. Turbo C++ 3.0
now uses the industry-standard DPMI (DOS Protected Mode



Interface) protocol that runs the compiler (as well as the IDE,
the linker, and other programs) in DOS protected mode.

m Programmer’s Platform: Turbo C++ 3.0 comes with an
improved version of the Programmer’s Platform, Borland’s
open-architecture IDE that gives you access to the following full
range of programming tools and utilities:

« a multi-file editor, featuring both an industry-standard
Common User Access (CUA) interface and a familiar alternate
interface, compatible with previous versions of Turbo C++

¢ advanced Turbo Editor Macro Language (TEML) and
compiler
« multiple overlapping windows with full mouse support

o fully integrated debugger running in DPMI, for debugging
large applications

o support for inline assembler code
o complete undo and redo capability with an extensive buffer

and much more.

m VROOMM: Turbo C++7% Virtual Run-time Object-Oriented
Memory Manager lets you overlay your code without
complexity. You select the code segments for overlaying;
VROOMM takes care of the rest, doing the work needed to fit
your code into 640K.

m Help: Online context-sensitive hypertext help has copy-and-
paste program examples for practically every function.

m Streams: Turbo C++ includes full support for C++ iostreams,
plus special Borland extensions.

m Container classes: Advanced container class libraries gives
you sets, bags, lists, arrays, B-trees and other reusable data
structures, implemented both as templates and as object-based
containers for maximum flexibility.

Other features:

m Over 200 new library functions for maximum flexibility and
compatibility. :
m Complex and BCD math, fast huge arithmetic.

m Heap checking and memory management functions, with far
objects and huge arrays.
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m New BGI fonts and BGI support for the full ASCII character set.
m Response files for the command-line compiler.
m NMAKE compatibility for easy transition from Microsoft C.

Hardware and software requirements

Turbo C++ runs on the IBM PC compatible family of computers,
including the AT and PS/2, along with all true IBM compatible
286, 386 or 486 computers. Turbo C++ requires a 286 or higher,
DOS 3.31 or higher, a hard disk, a floppy drive, and at least 640K
plus 1IMB of extended memory; it runs on any 80-column monitor.

Turbo C++ includes floating-point routines that let your programs

- make use of an 80x87 math coprocessor chip. It emulates the chip

if it is not available. Though it is not required to run Turbo C++,
the 80x87 chip can significantly enhance the performance of your
programs that use floating point math operations.

Turbo C++ also supports (but ‘does not require) a mouse.

The Turbo C++ implementation

Turbo C++ is a full implementation of the AT&T C++ version 2.1,
and it includes an implementation of templates. It also supports
the American National Standards Institute (ANSI) C standard. In
addition, Turbo C++ includes certain extensions for mixed-
language and mixed-model programming that let you exploit
your PC’s capabilities.

The Turbo C++ pdc_kcge

Infroduction

Your Turbo C++ package consists of a set of disks and this
manual, which tells you how to use the product, how to program
in C and C++, and how to use specialized programming tools.

In addition to this manual, you'll find a convenient Quick
Reference card. The disks contain all the programs, files, and
libraries you need to create, compile, link, and run your Turbo
C++ programs; they also contain sample programs, many
standalone utilities, a context-sensitive help file, an integrated
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debugger, and additional C and C++ documentation not covered
in this documentation.

- The User’s Guide introduces you to Turbo C++ and shows you

how to create and run both C and C++ programs. It consists of in-
formation you'll need to get up and running quickly, and.
provides reference chapters on the features of Turbo C++:
Borland’s Programmer’s Platform, including the editor and Project
Manager, as well as details on using the command-line compiler.
This manual includes the following chapters:

Introduction introduces you to Turbo C++ and tells you where to
look for more information about each feature and option.

Chapter 1: Installing Turbo C++ tells you how to install Turbo
C++ on your system; it also tells you how to customize the colors,
defaults, and many other aspects of Turbo C++.

Chapter 2: IDE Basics introduces the features of the
Programmer’s Platform, tells you how to start up and exit from
the IDE, and presents examples of how to use the IDE.

Chapter 3: An introduction to C++ covers basic C++ syntax.

Chapter 4: Object-oriented programming with C++ describes the
major concepts involved in object-oriented programming.

Chapter 5: Hands-on C++ is step-by-step instruction in C++
programming,. ,
Chapter 6: Debugging in the new IDE is a tutorial on how to
debug a C program.

Chapter 7: Managing multi-file projects introduces you to Turbo
C++% built-in project manager and shows you how to build and
update large projects from within the IDE.

Chapter 8: The command-line compiler tells how to use the
command-line compiler and configuration files.

Chapter 9: MAKE: The program manager introduces the Turbo
C++ MAKE utility, describes its features and syntax, and presents
some examples of usage. '
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Chapter 10: TLINK: The Turbo linker is a complete reference to the
features and functions of the Turbo Linker (TLINK).

Chapters 11: Lexical elements describes the Turbo C++ language
tokens.

Chapter 12: Language structure explains how C++ tokens can be
grouped together.

Chapter 13: C++ specifics describes details of the language and
how to use C++ with and without the classes.

Chapter 14: The preprocessor describes preprocessor directives,
their syntax and semantics, and the macro processor incorporated
in the preprocessor.

Chapter 15: The main function describes the main function.

Chapter 16: Using C++ streams tells you how to use the C++
iostreams library. '

Chapter 17: Converting from Microsoft C provides some
guidelines on converting your Microsoft C programs to Turbo
C++.

Chapter 18: Memory management briefly describes the DOS
Protected Mode Interface (DPMI) and other memory-related
topics.

Chapter 19: Mathematical operations covers floating-point and
BCD math.

Chapter 20: Video functions is devoted to handling text and
graphics in Turbo C++. ' ‘

Appendix A: Editor reference provides a convenient command
reference to using the editor with both the CUA command
interface and the Turbo C++ alternate interface.

Appendix B: Precompiled headers tells you how to use Turbo
C++%s exclusive precompiled headers feature to save substantial
time when recompiling large projects.

Appendix C: Error messages lists and explains run-time,
compile-time, linker, librarian, and Help compiler errors and
warnings with suggested solutions.



Online

documentation

In addition to the README.DOC and HELPME!.DOC, the
following online documents are included with Turbo C++:

m ANSI.DOC covers those aspects of the ANSI C standard that
have been left loosely defined or undefined by ANSI and how
Borland has chosen to implement them.

m CONTAIN.DOC tells you how to use the Turbo C++ container
class library in your programs.

m UTIL.DOC tells how to write inline assembly language functions
that can be assembled with the built-in assembler (BASM) and
used within your Turbo C++ program.

m UTIL.DOC describes TLIB and other utilities. -

m Online help describes functions in the run-time library and
contains information of a wide-range of other topics.

Using the manual

Programmers
learning C or C++

The manual is arranged so you can pick and choose among the
chapters to find exactly what you need to know at the time you
need to know it.

If you don’t know C or C++, there are many good products on the
market that can get you going in these languages. You can use
Chapters 11 through 16 for reference on specific technical aspects
of Turbo C++.

Your next step is to start programming in C and C++. Chapter 15,
“The main function,” provides information on aspects of the
main() function that is seldom found elsewhere. Or, you might
prefer to use the online help; it contains much of the same
information, and includes programming examples that you can
copy into your own programs.
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Typefoces and icons used in these books

Monospace type

ALL CAPS
0

Boldface

Italics

Keycaps

o=

o

This typeface represents text as it appears onscreen or in a pro-
gram. It is also used for anything you must type literally (such as
TC to start up Turbo C++ 3.0).

We use all capital letters for the names of constants and files.

Square brackets [ ] in text or DOS command lines enclose optional
items that depend on your system. Text of this sort should not be
typed verbatim.

Angle brackets in the function reference section enclose the names
of include files.

Turbo C++ function names (such as printf), class, and structure
names are shown in boldface when they appear in text (but not in-
program examples). This typeface is also used in text for Turbo

. C++ reserved words (such as char, switch, near, and cdecl), for

format specifiers and escape sequences (%d, \t), and for
command-line options (/A).

Italics indicate variable names (identifiers) that appear in text.
They can represent terms that you can use as is, or that you can
think up new names for (your choice, usually). They are also used
to emphasize certain words, such as new terms.

This typeface indicates a key on your keyboard. For example,
“Press Esc to exit a menu.”

This icon indicates keyboard actions.

This icon indicates mouse actions.

@@> This icon indicates language items that are specific to C++.

How to contact Borlond‘

Introduction

Borland offers a variety of services to answer your questions
about this product. Be sure to send in the registration card;
registered owners are entitled to technical support and may
receive information on upgrades and supplementary products.



Resources in your
package

Borland resources

800-822-4269 (voice)
Techfax

408-439-9096 (modem)
File Download BBS
2400 Baud

Online information services

408-438-5300 (voice)
Technical Support
6 a.m. fobp.m. PST

This product contains many resources to help you:

m The manual provides information on every aspect of the
program. Use it as your main information source.

- mWhile using the program, you can press F1 for help.

m Many common questions are answered in the DOC files listed
in the README file located in the program directory.

Borland Technical Support publishes technical information sheets
on a variety of topics and is available to answer your questions.

TechFax is a 24-hour automated service that sends free technical
information to your fax machine. You can use your touch-tone
phone to request up to three documents per call.

The Borland File Download BBS has sample files, applications,
and technical information you can download with your modem.
No special setup is required.

Subscribers to the CompuServe, GEnie, or BIX information
services can receive technical support by modem. Use the
commands in the following table to contact Borland while
accessing an information service.

Service Command

- CompuServe GO BORLAND
BIX JOIN BORLAND
GEnie BORLAND

Address electronic messages to Sysop or All. Don’t include your
serial number; messages are in public view unless sent by a
service’s private mail system. Include as much information on the
question as possible; the support staff will reply to the message
within one working day.

Borland Technical Support is available weekdays from 6:00 a.m.
to 5:00 p.m. Pacific time to answer any technical questions you
have about Borland products. Please call from a telephone near
your computer, and have the program running. Keep the
following information handy to help process your call:

m Product name, serial number, and version number.
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408-438-5300 (voice)
Customer Service
7 a.m. to 5 p.m. PST

Introduction

u The brand and model of any hardware in your system.

m Operating system and version number. (Use the. DOS command
VER to find the version number.)

m Contents of your AUTOEXEC.BAT and CONFIG.SYS files

(located in the root directory (\) of your computer’s boot disk).
m A daytime phone number where you can be contacted.

m If the call concerns a problem, the steps to reproduce the
problem.

Borland Customer Service is available weekdays from 7:00 a.m. to
5:00 a.m. Pacific time to answer any non-technical questions you
have about Borland products, including pricing information,
upgrades, and order status.
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Your Turbo C++ package
includes two different
versions of Turbo C++: the IDE
(Programmer’s Platform) and
the DOS command line
version.

IMPORTANT! To create
backup copies of your disks,
put the backup on the same
type of disk as the source. For
example, if you're backing
up the 5 1/4-inch 1.2 Mb disk
set, use only blank 5 1/4-inch
1.2 Mb disks for backup. The
installation doesn’t work
correctly unless the original
disks and backup disks are

" the same type of storage
media.

Installing Turbo C++

Turbo C++ comes with an automatic installation program called
INSTALL. Because we used file-compression techniques, you
must use this program; you can’t just copy the Turbo C++ files
onto your hard disk. Instead, INSTALL automatically copies and
uncompresses the Turbo C++ files. For reference, the README
file on the installation disk includes a list of the distribution files.

We assume you are already familiar with DOS commands. If you
don’t already know how to use DOS commands, refer to your
DOS reference manual before setting up Turbo C++ on your
system. For example, you'll need the DISKCOPY command to
make backup copies of your distribution disks. Make a complete
working copy of your distribution disks when you receive them,
then store the original disks away in a safe place.

None of Borland’s products use copy protection schemes. If you
are not familiar with Borland’s No-Nonsense License Statement,
read the agreement included with your Turbo C++ package. Fill
in the product registration card and return it by mail to Borland.
Returning this information ensures that you'll receive important
upgrades and new product announcements promptly.

This chapter contains the following information:

m installing Turbo C++ on your system
m accessing the README file

" maccessing the HELPME! file

Chapter 1, Installing Turbo C++ | 13



m a pointer to more information on example programs
m information about customizing Turbo C++ default settings,
display colors, and so on.

‘Once you have installed Turbo C++, you'll be ready to start
digging into Turbo C++. The Introduction tells where to find out
more about Turbo C++ features in the documentation.

Using INSTALL

We recommend that you  INSTALL detects what hardware you're using and configures

studly fhi’ffﬁfe '\g;gewt;if o Turbo C++appropriately. It creates required directories and
installation.  transfers files from the distribution disks to your hard disk. The

distribution disks are the disks included in the Turbo C++
product package.

To install Turbo C++, perform the folldwing steps:

1. Insert the installation disk (disk 1) into drive A. Type the
following command, then press Enter.

A:INSTALL
2. Press Enter at the installation screen.
3. Follow the prompts.

4. At the end of installation, you might want to add the
following line to your CONFIG.SYS file:

FILES = 20

You might want to add the following line to your
AUTOEXEC.BAT file or change your PATH statement
accordingly:

PATH = C:\TC\BIN

Important!  When INSTALL is finished, it displays the README file, which
contains important, last-minute information about Turbo C++.
The HELPME!DOC file is available to answer many common
technical support questions, also.

Protected mode

~and memory Turbo C++ utilizes the DPMI (Dos Protected Mode Interface) to
run the compiler in protected mode, giving you access to all your
computer’s memory without swapping. The protected mode
interface is transparent to the user, and you usually don’t have to
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think about it. The following sections discuss the rare
circumstances that require your interaction with the DPMI

DPMIINST ~ When you run Turbo C++ for the first time, you might receive an
error message and have to run DPMIINST. Turbo C++ uses an
internal database of various machine characteristics to determine
how to enable protected mode operations on your machine, and it
configures itself accordingly. If your machine isn’t recognized by
Turbo C++, you receive the following error message:

Machine not in database (RUN DPMIINST)

- If you get this message, run the DPMIINST program by typing the
following command at the DOS prompt:

DPMIINST

Follow the program’s instructions. DPMIINST runs your machine
through a series of tests to determine the best way of enabling
protected mode, and automatically configures Turbo C++
accordingly. Once you run DPMIINST, you never have to run it
again.

DPMIMEM By default, the Turbo C++ DPMI interface allocates all available
extended and expanded memory for its own use. If you don't
want all of the available memory to be taken by the DPMI kernel,
set the environment variable DPMI, which specifies a maximum
amount of memory to use, using the following syntax:

set DPMIMEM=MAXMEM nnnn
where nnnn is the amount of memory in kilobytes.

You can set DPMIMEM by entering the command at the DOS
prompt, or you can put it into your AUTOEXEC.BAT file to set
DPMIMEM automatically.

For example, if a user has a system with 4MB and wants the
DPMI kernel to use 2MB of it, leaving the other 2MB alone, the
DPMIMEM variable would be set as follows:

c:> set DPMIMEM=MAXMEM 2000

Chapter 1, Installing Turbo C++ ; , 15



DPMIRES

Extended and
expanded memory

DPMIRES is a utility that can be used with Turbo C++ to increase
performance of some language tools under certain conditions. In .
particular, the performance of TCC and TLINK can be enhanced
through its use.

When run, DPMIRES enables the Dos Protected Mode interface
and spawns a DOS command shell. Applications such as TLINK
load faster into this shell. Typing ‘EXIT to the shell removes it.

DPMIRES is especially useful if you're compiling with batch files,
instead of using the protected mode MAKE. In this situation, it’s

‘more efficient to run DPMIRES before running the batch file, since

the compile loads faster on each invocation.

Once the DPMI kernel is loaded (either by running TC or through
the DPMIRES utility), the Turbo C++ integrated development
environment interacts directly with the DPMI server to allocate its
memory during both loading and operating. By default, the IDE
uses all the extended memory reserved by the DPMI kernel and
all available EMS (expanded) memory with the EMS memory
being used as a swap device.

" The Options | Environment | Startup... dialog items (Use Extended

Memory and Use EMS Memory) and the corresponding /X and /E
command line switches change the default method of memory
allocation, which affects how much memory the IDE uses. The
settings don’t change the memory reserved by the kernel itself.

The Use Extended Memory dialog item corresponds to the /X
command line option. It tells TC how much of the memory
reserved by the DPMI kernel to use. By limiting TC’s use of the
kernel’s memory, other DPMI applications can be run from within
the IDE’s memory (using the Transfer capability), or other

‘applications can be run from a DOS shell opened from the IDE.

The Use EMS Memory dialog item corresponds to the /E
command line option. It tells the IDE how many 16K EMS pages
to use as a swap device. Unless the kernel has been instructed to -
set aside some available memory, no EMS pages are available to
the IDE. : ‘
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Running Turbo

C++  Once you have installed Turbo C++, change to the Turbo C++ \
BIN directory, type TC and press Enter.

After experimenting with the IDE, select the Options |
Environment | Startup and Options | Environment | Colors if you
want to customize the IDE.

Laptop systems ,
If you have a laptop computer (one with an LCD or plasma
display), set your screen parameters before using Turbo C++ to

the recommended setting by typing the following command at
the DOS prompt:

MODE BW80

To set the MODE automatically, either create a batch file to set
Mode to BW80, or better yet, install Turbo C++ for a black-and-
white screen from within the IDE using the Options |
Environment | Startup option. Choose “Black and White / LCD"
from the Video options group.

The README file

The README file contains last-minute information that might not
be in the manual.

Turbo C++ automatically displays the README file when you
run the INSTALL program. To access the README file at a later
time type the following command at the DOS command line:

README

The FILELIST.DOC and HELPME!.DOC files

Other files on the installation disk are FILELIST.DOC and
HELPME!.DOC. FILELIST.DOC briefly describes every file on the
distribution disk. HELPME!.DOC contains answers to
frequently-encountered problems. Consult these files to try to
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solve difficulties. You can use the README prografn to look at
HELPME!DOC. Type the following command at the command
line:

README HELPME!.DOC

Example programs

Your Turbo C++ package includes the source code for a large
number of example programs in C and C++, including a complete
spreadsheet program called Turbo Calc. These programs are
located in the EXAMPLES directory (and subdirectories) created
by INSTALL. The EXAMPLES directory also contains
subdirectories for examples of the other tools and utilities that
come with Turbo C++. Before you compile any of these example
programs, you should read the printed or online documentation
for them.

Customizing the IDE

For deftailed information on

the menus and options in the

18

IDE, see Chapter 2, “IDE
Basics.”

Turbo C++ allows you to customize your installation from within
the IDE, using the various options in the Options | Environment
menu. The options specify the video mode, editing modes, default
directories, menu colors, and control color syntax highlighting
during debugging.
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IDE basics

Borland’s Programmer’s Platform, also known as the integrated
development environment or IDE, has everything you need to
write, edit, compile, link, and debug your programs. It provides

m multiple, movable, resizable windows

m mouse support and dialog boxes

m syntax highlighting in colors you can change

mcut, paste, and copy commands that use the Clipboard

m full editor undo and redo

m online Help

m examples ready to copy and paste from Help

m a built-in assembler

m quick transfer to other programs and back again

m an editor macro language

This chapter explains how to start up and exit the Turbo C++ IDE,
discusses its generic components, and explains how configuration
and project files work. The table at the end of the chapter cross-

references IDE menu items to descriptions throughout the
manual.
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Starting and exiting

20

Turbo C++runsonly in - To start the IDE, type TC at the DOS prompt. You can follow it

_protfected mode.

Command-line
options

The /b Qpﬁon

with one or more IDE command-line options.

The command-line options for Turbo C++'s IDE are /b, /d, /e, /h, /l,
/m, Ip, Irx, Is, and /x using this syntax:

TC [option [option...]] [sourcename | projectname [sourcename]]

where option can be one or more of the options, sourcename is any
ASCII file (default extension assumed), and projectname is your
project file (it must have the .PR] extension). The order and case is
not important.

To turn an option off, follow the option with a minus sign. For
example,

C /e-

turns off the default swap to expanded memory option.

The /b (build) option causes Turbo C++ to recompile and link all
the files in your project, print the compiler messages to the
standard output device, and then return to the operating system.
This option lets you start Turbo C++ from a batch file so you can
automate project builds. Turbo C++ determines what .EXE to
build based on the file you specify on the command line. If it
doesn’t find a project file it builds the active file loaded into the
IDE edit window. It looks for project file (.PR]) and source file
(.CPP) extensions.

To specify a project file, enter the TC command followed by /b and
the project file name. For example,

TC /b myproj.prj

If there is no MYPROG.PRY file, the following command loads the
file MYPROG.CPP in the editor and then compiles and links it:

TC MYPROG /B
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The /d option

The /e option

The /h option

Chapter 2, IDE basics

The /d option causes Turbo C++ to run in dual momtor mode if it
detects two video cards installed in your computer (for example a
monochrome card and a color card); otherwise, the /d option is
ignored. Using dual monitor mode makes it easier to watch a
program’s output while you are debugging the program.

If your system has two monitors, DOS treats one monitor as the

active monitor. Use the DOS MODE command to switch between

the two monitors (MODE C080, for example, or MODE MONO). In dual
monitor mode, the normal Turbo C++ screen appears on the
inactive monitor, and program output goes to the active monitor.
So when you type TC /d at the DOS prompt on one monitor, Turbo
C++ comes up on the other monitor. When you want to test your
program on a particular monitor, exit Turbo C++, switch the
active monitor to the one you want to test with, and then issue the
TC /d command again. Program output then goes to the monitor
where you typed the TC command.

Keep the following in mind when using the /d option:

m Don’t change the active monitor (by using the DOS MODE
command, for example) while you are in a DOS shell (File | DOS
Shell).

u User programs that directly access ports on the inactive moni-
tor’s video card are not supported, and have unpredlctable
results.

m Don’t use it when you run or debug programs that explicitly
make use of dual monitors.

The /e option tells Turbo C++ to swap to expanded memory if
necessary; it is on by default. The syntax for this option is as
follows:

/e[=n]

where n equals the number of pages of expanded memory that
you want the IDE to use for swapping. Each page is 16K.

Typing TC /h on the command line, you get a list of all the
command-line options available. Their default values are also
shown.
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The /I option

The /m option

The /p option

The /r option

The /s option

The /x opftion

Use the /l (lowercase 1) option if you're running Turbo C++ on an
LCD screen.

The /m option lets you do a make rather than a build. That is, only
outdated source files in your project are recompiled and linked.
Follow the instructions for the /b option, but use /m instead. See
page 297 for MAKE information.

If your program modifies the EGA palette registers (or has BGI do
it), use the /p option, which controls palette swapping on EGA
video adapters. The EGA palette is restored each time the screen
is swapped.

- Use /rx to specify a swap drive, usually a RAM disk, if all your

virtual memory fills up. The x in /rx is the letter of the swap drive.
For example, /rd specifies drive D as the swap drive.

Using the /s option, (on by default) the compiler allows the
majority of available memory to be allocated for its internal tables
while compiling. If it is compiling large modules, little memory
may remain for the needed overlays; therefore, the compiler may
spend a long time “thrashing,” that is, swapping overlays in and
out of memory.

If you specify /s-, the compiler won’t permit its internal tables to
severely restrict the overlay space in memory. As a result, if you
are compiling very large modules, the compilation may fail and
you'll get an out-of-memory error, but the compiler won’t thrash
excessively.

Use the /x switch to tell Turbo C++ how much of the availabie
extended memory to use for its heap space.

/x
uses all available memory.
/X[=n]

where 7 equals the amount of memory in kilobytes, let’s you
specify how much extended memory should be used.
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Exiting Turbo C++
There are three ways to leave the IDE.

m Choose File | Exit to leave the IDE completely; you have to type
TC again to reenter it. You'll be prompted to save your
programs before exiting, if you haven’t already done so.

m Choose File | DOS Shell to shell out from the IDE to enter
commands at the DOS command line. When you're ready to
return to the IDE, type EXIT at the command line and press Enter.
The IDE reappears just as you left it.

You return fo the IDE ofter  m Choose a program from the System menu (=) to temporarily
you exit fherp rogiamyou  transfer to another program without leaving the IDE. You can
ransferred to. . .
add new Transfer programs with the Options | Transfer
command.

IDE components

There are three visible components to the IDE: the menu bar at the
top, the window area in the middle, and the status line at the bot-
tom of the screen. Many menu items also offer dialog boxes.
Although there are several different ways to make selections in
the IDE, they access the same commands and dialog boxes. Before
we list menu items in the IDE, we’ll explain these more generic
components.

The menu bar

and menus The menu bar is your primary access to all the menu commands.
The menu bar is always visible except when you're viewing your
program’s output or transferring to another program.

If a menu command is followed by an ellipsis (...), choosing the
command displays a dialog box. If the command is followed by
an arrow (»), the command leads to another menu. If the
command has neither an ellipsis nor an arrow, the action occurs
as soon as you choose the command.

Here is how you choose menu commands using the keyboard:

=

== 1. Press F10. This makes the menu bar active; the next thing you

type will felate to the items on the menu bar.
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To cancel an action,
press Esc.

&

Turbo C++ uses only the left

mouse button. You can,

however, customize the right

button and make other
mouse option changes, by
choosing Options |
Envirohment | Mouse.

Shortcuts

Input boxes are described on

24
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2. Use the arrow keys to select the menu you want to display.
Then press Enter.

As a shortcut for this step, you can just press the highlighted
letter of the menu title. For example, when the menu bar is
active, press E to move to and display the Edit menu. At any
time, press Alf and the highlighted letter (such as Alt+E) to
display the menu you want.

3. Use the arrow keys again to select a command from the menu
you've opened. Then press Enter.

At this point, Turbo C++ either carries out the command,
displays a dialog box, or displays another menu.

There are two ways to choose commands with a mouse:

m Click the desired menu title to display the menu and click the
desired command.

m Or, drag straight from the menu title down to the menu
command. Release the mouse button on the command you
want. (If you change your mind, just drag off the menu; no
command will be chosen.)

Note that some menu commands are unavailable when it would
make no sense to choose them. However, you can always get
online Help about currently unavailable commands.

Turbo C++ offers a number of quick ways to choose menu
commands. The click-drag method for mouse users is an example.
From the keyboard, you can use a number of keyboard shortcuts
(or hot keys) to access the menu bar, choose commands, or work
within dialog boxes. You need to hold down Alt while pressing the
highlighted letter when moving from an input boxto a group of
buttons or boxes. Here’s a list of the shortcuts available:

Do this... To accomplish this...

Press Alt plus the highlighted Display the menu or carry out the
letter of the command (just command.

press the highlighted letter

in a dialog box). For the

= menu, press Alt+Spacebar.

Type the keystrokes nexttoa - Carry out the command.
menu command.

For example, to cut selected text, press Alt+E T (for Edit | Cut) or
you can just press. Shift+Del, the shortcut displayed next to it.
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Commdnd sets Turbo C++ has two command sets: the Common User Access

(CUA) command set and the Alternate command set popularized
in previous Borland products. The set determines the shortcuts
available to you, which keys you use within the editor, and, to
some extent, how the editor works. See more about using
command sets in the editor in Appendix A. A Native command
set option is discussed at the end of this section.

You can select a command set by choosing Options |

Environment | Preferences and then selecting the command set
you prefer in the Preferences dialog box. If you are a long-time
Borland language user, you may prefer the Alternate command

set.

The following tables list the most-used Turbo C++ hot keys in
both command sets.

Table 2.1: General hot keys

Menu item

CUA Alternate Function
F1 F1 Help Displays context-sensitive help screen.
F2 File|Save Saves the file that’s in the active edit window.
F3 File | Open Brings up a dialog box so you can open a file.
F4 Run | Go to Cursor Runs your program to the line where the cursor is
‘ positioned.
F5 Window | Zoom Zooms the active window.
Cirl+F6  F6 Window | Next Cycles through all open windows.
F7 F7 Run | Trace Into Runs your program in debug mode, tracing into
functions.
F8 F8 " Run | Step Over Runs your program in debug mode, stepping over
function calls.
F9 . F9 Compile | Make Invokes the Project Manager to make an .EXE file.
F10 F10 (none) Takes you to the menu bar.

Table 2.2: Menu hot keys

Alt+S

Chapter 2, IDE basics

CUA Alternate. Menu item Function
Alt+Spacebar  Alt+Spacebar = menu Takes you to the = (System) menu
Alt+C Alt+C Compile menu Takes you to the Compile menu
Alt+D Alt+D Debug menu Takes you to the Debug menu
Al+E Al+E Edit menu Takes you to the Edit menu
Alt+F Alt+F File menu Takes you to the File menu

. Alt+H Alt+H Help menu Takes you to the Help menu
Alt+0 Alt+O . Options menu Takes you to the Options menu
Alt+P Alt+P Project menu Takes you to the Project menu
Alt+R Alt+R. Run menu Takes you to the Run menu
Alt+S - Search menu Takes you to the Search menu
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Table 2.2: Menu hot keys (continued)

Alt+W AW . Window menu Takes you to the Window menu
Alt+F4 Alt+X File | Exit - Exits Turbo C++ to DOS
Table 2.3: Editing hot keys
CUA Alternate  Menu item Function
Ctrltns Clrl+ins Edit| Copy Copies selected text to Clipboard
Shift+Del Shift+Del Edit | Cut Places selected text in the Clipboard,
deletes selection -
Shift+ins Shift+Ins Edit | Paste Pastes text from the Clipboard into the
active window
Ctri+Del Ctri+Del Edit | Clear Removes selected text from the window
but doesn’t put it in the Clipboard
Alt+Bkspe Alt+Bkspc  Edit! Undo Restores the text in the active window to a
previous state
Alt+Shft+Bksp Alt+Shft+Bksp Edit | Redo “Undoes” the previous Undo.
F3 Clri+L Search|Search Again  Repeats last Find or Replace command
F2 File | Save Saves the file in the active edit window
F3 File | Open Lets you open a file

Table 2.4: Window management hot keys

CUA Alternate  Menu item Function
Alt+# Alt+# Displays a window, where # is the number
of the window you want to view
Alt+0 Altz0  Window | List All Displays a list of open windows
Ctrl+F4 Alt+F3 Window | Close Closes the active window
Shift+F5 Window | Tile Tiles all open windows
Alt+F5 Alt+F4 Debug | Inspect Opens an Inspector window
Shift+F5 Alt+F5 Window | User Screen = Displays User Screen
F5 Window | Zoom Zooms/unzooms the active window
Cirl+F6 F6 Window | Next Switches the active window
Cirl+F5 Changes size or position of active window

Table 2.5: Online Help hot keys

CUA Alternate = Menu item Function

F1 -~ F1 Help | Contents Opens a context-sensitive help screen

F1F1 F1F1 Brings up Help on Help. (Just press F1
when you're already in the help system.)

Shift+F1 Shift+F1 Help | Index Brings up Help index

All+F1 Alt+F1 - Help | Previous Topic ~ Displays previous Help screen .

Cirl+F1 Cirl+F1 Help | Topic Search Calls up language-specific help (in the
active edit window)

26
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Table 2.6: Debugging/Running hot keys

CUA Alternate  Menu item ‘ Function
Alt+F5 Alt+F4 Debug | Inspect Opens an Inspector window
Alt+F7 Alt+F7 Search | Previous Error Takes you to previous error
Alt+F8 Alt+F8 Search | Next Error Takes you to next error
Alt+F9 Alt+F9 Compile | Compile to OB]  Compiles to .OBJ
Ctri+F2 Ciri+F2 Run [ Program Reset Resets running program
Ctrl+F3 Debug | Call Stack Brings up call stack
Clrl+F4 Debug | Evaluate/Modify  Evaluates an expression
Ctr+F5 Ctri+F7 Debug | Add Watch Adds a watch expression
F5 Ctrl+F8 Debug | Toggle Breakpoint Sets or clears conditional breakpoint
Ctri+F9 Ctri+F9 Run | Run Runs program
F4 Run | Go . To Cursor Runs program to cursor position
F7 F7 Run | Trace Into Executes one line, tracing into functions
F8 F8 Run|Step Over Executes one line, skipping function calls
F9 F9 Compile | Make Makes (compiles/links) program

Native makes the Alternate

command set the default.

If you exit Turbo C++ with a

Turbo C++
windows

file open in a window, you
are returned fo your desktop,

open file and all, when you

next use Turbo C++.

Chapter 2, IDE basics

Native option

If you choose Options | Environment | Preferences to display the
Preferences dialog box, you'll notice another option: Native. This
is the default setting.

The IDE uses the configuration file, TCCONFIG.TC, to determine
which command set is in effect. Therefore, if you have selected the
CUA command set in the IDE, that is the one in effect the next
time you start up.

With Native selected, Turbo C++ for DOS uses the Alternate
command set automatically.

Most of what you see and do in the IDE happens in a window. A
window is a screen area that you can open, close, move, resize,
zoom, tile, and overlap.

You can have many windows open in the IDE, but only one
window can be active at any time. Any command you choose or
text you type generally applies only to the active window. (If you
have the same file open in several windows, the action will apply
to the file everywhere that it's open.)

You can spot the active window easily: It’s the one with the
double-lined border around it. The active window always has a
close box, a zoom box, and scroll bars. If your windows are over-
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Figure 2.1
A typical window

lapping, the active window is always the one on top of all the
others (the foremost one).

There are several types of windows, but most of them have these
things in common:

m a title bar
® a close box
‘mscroll bars
m a zoom box
m a window number (1 to 9)

A edit window also displays the current line and column num-
bers in the lower left corner. If you've modified your file, an aste-
risk (* ) appears to the left of the column and line numbers.

The following figure shows a typical window:

The iﬁ]ﬂ@ contains
the name of the window.

Click the Click on the
to : to either enlarge or
quickly close shrink the window.
the window. —l—
! o !
— =[] Window Title =—————————=3 =[T]—~———l “
N

The first nine open
windows have a @m
[GRER. Use Alt and #

to make the # active.

Use a mouse to scroll the . >
contents of the window

I Drag any corner to make
windows larger or smaller

The close box of a window is the box in the upper left corner. Click
this box to quickly close the window. (Or choose Window | Close.)
The Inspector and Help windows are considered temporary; you
can close them by pressing Esc.
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Shortcut: Double-click the
title bar of a window to zoom
or restore it.

=™

Alt+0 gives you a list of all
windows you have open.

Scroll bars also show you
where you are in your file.

L%

Window management

: Table 2.7
Manipulating windows

Chapter 2, IDE basics

The title bar, the topmost horizontal bar of a window, contains the
name of the window and the window number. Double-clicking

- the title bar zooms the window. You can also drag the title bar to

move the window around.

The zoom box of a window appears in the upper right corner. If the
icon in that corner is an up arrow (%), you can click the arrow to
enlarge the window to the largest size possible. If the icon is a
doubleheaded arrow (%), the window is already at its maximum
size. In that case, clicking it returns the window to its previous
size. To zoom a window from the keyboard, choose Window |
Zoom.

The first nine windows you open in Turbo C++ have a window
number in the upper right border. You can make a window active
(and thereby bring it to the top of the heap) by pressing Altin
combination with the window number. For example, if the Help
window is #5 but has gotten buried under the other windows,
Alt+5brings it to the front.

" Scroll bars are horizontal or vertical bars that look like this:

» - >

You use these bars with a mouse to scroll the contents of the

window. Click the arrow at either end to scroll one line at a time.
(Keep the mouse button pressed to scroll continuously.) You can
click the shaded area to either side of the scroll box to scroll a
page at a time. Finally, you can drag the scroll box to any spot on
the bar to quickly move to a spot in the window relative to the
position of the scroll box. :

You can drag any corner to make a window larger or smaller. To
resize using the keyboard, choose Size/Move from the Window
menu.

Table 2.7 gives you a quick rundown of how to handle windows
in Turbo C++. Note that you don’t need a mouse to perform these
actions—a keyboard works just fine. :

To accomplish this: Use one of these methods

Open an edit window Choose File | Open to open a file and
' display it in a window. /

Open other windows Choose the desired window from the
Window menu
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The status line

Table 2.7: Manipulating windows (contfinued)

Close a window Choose Close from the Window menu or
click the close box of the window.

Activate a window Click anywhere in the window, or

Press Alt plus the window number (1 to 9,
in the upper right border of the window),
or

Choose Window | List or press Alt+0 and
select the window from the list, or

Choose Window | Next to make the next
window active (next in the order you first
opened them).

Move the active window Drag its title bar. Or choose Window |
Size/Move and use the arrow keys to place
the window where you want it, then press
Enter.

Resize the active window  Drag any corner. Or choose Window |
Size /Move and press Shift while you use
the arrow keys to resize the window, then
press Enter.

Zoom the active window Click the zoom box in the upper right
corner of the window, or -

Double-click the window's title bar, or

Choose Window | Zoom.

The status line appears at the bottom of the screen. It

m reminds you of basic keystrokes and shortcuts (or hot keys)
applicable at that moment in the active window.

m lets you click the shortcuts to carry out the action instead of
choosing the command from the menu or pressing the shortcut
keystroke. ' .

m tells you what the program is doing. For example, it displays
Saving filename... when an edit file is being saved.

m offers one-line hints on any selected menu command and dialog
box items. ‘

The status line changes as you switch windows or activities. One
of the most common status lines is the one you see when you're
actually writing and editing programs in an edit window. Here is
what it looks like:
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Figure 2.2
A typical status line

Dialog boxes

Figure 2.3
A sample dialog box

If you have a color monitor,
Turbo C++ uses different
colors for various elements of
the dialog box.

Action buttons

You can select another
button with Tab; press Enter to
choose that button,

Chapter 2, IDE basics

F1 Helip F2 Save F3 Open F7 Trace F8 Step F9 Make F10 Menu

When you've selected a menu title or command, the status line
changes to display a one-line summary of the function of the
selected item.

A menu command with an ellipsis (...) after it leads to a dialog box.
Dialog boxes offer a convenient way to view and set multiple
options. When you’re making settings in dialog boxes, you work
with five basic types of onscreen controls: action buttons, radio
buttons, check boxes, input boxes, and list boxes. Here’s a sample
dialog box that illustrates some of these items:

Option B
Option C
Option D

10 BuU
J 0pt1on A

This dialog box has thrée standard buttons: OK, Cancel, and Help.
If you choose OK, the choices in the dialog box are accepted; if
you choose Cancel, nothing changes, no action takes place, and
the dialog box is put away. Choose Help to open a Help window
about this dialog box. Escis always a keyboard shortcut for
Cancel (even if no Cancel button appears).

If you're using a mouse, click the dialog box button you want.
When you're using the keyboard, press Al and the highlighted
letter of an item to activate it. For example, Alt+K selects the OK
button because the K in OK is highlighted. Press Tab or Shift+Tab to
move forward or back from one item to another in a dialog box.
Each element is highlighted when it becomes active.

In this dialog box, OK is the default button, which means you need
only press Enter to choose that button. (On monochrome systems,
arrows indicate the default; on color monitors, default buttons are
highlighted.) Be aware that tabbing to a button makes that button
the default.
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Radio buttons and
check boxes

None

[X] Checked check box.
[ ] Unchecked check box

Input and list boxes

You can control whether
history lists are saved to the
desktop using Options |
Environment | Desktop.
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Radio buttons are like car radio buttons. They come in groups,
and only one radio button in the group can be on at any one time.
To choose a radio button, click it or its text. From the keyboard,
select Altand the highlighted letter, or press Tab until the group is
highlighted and then use the arrow keys to choose a particular
radio button. Press Tab or Shift+Tab again to leave the group with
the new radio button chosen.

Check boxes differ from radio buttons in that you can have any
number of check boxes checked at any time. When you select a
check box, an x appears in it to show you it’s on. An empty box
indicates it’s off. To change the status of a check box, click it or its
text, press. Tab until the check box is highlighted and then press
Spacebar, or select Alt and the highlighted letter.

If several check boxes apply to a topic, they appear as a group. In
that case, tabbing moves to the group. Once the group is selected,
use the arrow keys to select the item you want, and then press
Spacebar to check or uncheck it. On monochrome monitors, the
active check box or group of check boxes will have a chevron
symbol (») to the left and right. When you press Tab, the chevrons
move to the next group of check boxes or radio buttons.

Input boxes let you type in text. Most basic text-editing keys work
in the text box (for example, arrow keys, Home, End, and Ins). If you
continue to type once you reach the end of the box, the contents
automatically scroll. If there’s more text than what shows in the
box, arrowheads appear at the end (<and »). You can click the
arrowheads to scroll or drag the text. If you need to enter control
characters (such as AL or *M) in the input box, then prefix the
character with a AP. So, for example, to enter AL into the input
box, hold down the Ctr'key and press P L. (This capability is useful
for search strings.)

If an input box has a down-arrow icon ( ) to its rlght there is an
associated history list. Click the { to display the list. You'll find text
you typed the last few times you used the input box. Press Enter to
choose an item from this list. The Find box, for example, has such
a history list, which keeps track of the text you searched for
previously. Try choosing a previous search string. You can also
edit an entry in the history list. Press Esc to exit from the history
list without making a selection.
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Here is what a history list for the Find text box might look hke if
you had used it six times previously:

Text to find G

struct date
printf(
char buf[7]
/*

return(0
return()

A final component of many dialog boxes is a list box, which lets
you scroll through and select from variable-length lists (often file
names) without leaving a dialog box. If a blinking cursor appears
in the list box and you know what you're looking for, you can
type the word (or the first few letters of the word) and Turbo C++
will search for it.

You make a list box active by clicking it or by choosing the high-
lighted letter of the list title (or press Tabuntil it’s highlighted).
Once a list box is displayed, you can use the scroll box to move
through the list or press T or | from the keyboard.

Configuration and project files

The configuration .

Chapfter 2, IDE basics

file

With configuration files, you can specify how you want to work
within the IDE. Project files contain all the information necessary
to build a project, but don’t affect how you use the IDE.

The IDE configuration file, TCCONFIG.TC, contains only
environmental (or global) information, including

m editor key binding and macros,
m editor mode setting (such as autoindent, use tabs, etc.),
m mouse preferences, and

m auto-save flags.

The configﬁration file is not required to build programs defined
by a project. The project (.PR]) file handles those details.
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Project files

The project directory

When you start a programming session, Turbo C++ looks for
TCCONFIG.TC first in the current directory and then in the
directory that contains TC.EXE. ‘

The IDE places all information needed to build a program into a
binary project file, a file with a .PR] extension. Project files contain
the settings for

m compiler, linker, make and librarian options

m directory paths

m the list of all files that make up the project

" mspecial translators (such as Turbo Assembler)

In addition, the project file contains other general information on

~ the project, such as compilation statistics (shown in the project

window), and cached autodependency information.

IDE .PR] project files correspond to the .CFG configuration files
that you supply to the command-line compiler (the default
command-line compiler configuration file is TURBOC.CFG). The
PRJCFG utility can convert .PR] files to .CFG files and .CFG files
to .PR] files. ‘

You can load project files in any of three ways:

1. When starting Turbo C++, give the project name with the .PR]
extension after the TC command; for example,
TC myproj.PRJ
You must use the .PR] extension to differentiate it from source
files.

2. If there is only one .PR] file in the current directory, the IDE
assumes that this directory is dedicated to this project and
automatically loads it.

3. To load a project from within the IDE, select Project | Open
Project.

When a project file is loaded from a directory other than the
current directory, the current DOS directory is set to where the

* project is loaded from. This allows your project to be defined in

terms of relative paths in the Options | Directories dialog box and
also allows projects to move from one drive to another or from
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Desktop files

You can set some of these
options on or off using
Opfions | Environment |
Desktop.

Changing project files

Default files

Chapter 2, IDE basics

one directory branch to another. Note, however, that changing
directories after loading a project may make the relative paths
incorrect and your project unbuildable. If this happens, change
the current directory back to where the project was loaded from.

Each project file has an associated desktop file (prjname.DSK) that
contains state information about the associated project. While
none of its information is needed to build the project, all of the
information is directly related to the project. The desktop file
includes

m the context information for each window of the desktop (for
example, your positions in the files or bookmarks)

m the history lists for various input boxes (for example, search
strings or file masks) ‘

m the layout of the windows on the desktop
m the contents of the Clipboard

m watch expressions

m breakpoints

Because each project file has its own desktop file, changing to
another project file causes the newly loaded project’s desktop to
be used, which can change your entire window layout. When you
create a new project (by using Project | Open Project and typing in
anew .PR]J file name), the new project’s desktop inherits the
previous desktop. When you select Project | Close Project, the
default project is loaded and you get the default desktop and

* project settings.

When no project file is loaded, there are two default files that
serve as global place holders for project- and state-related infor-
mation: TCDEF.DPR and TCDEF.DSK files, collectively referred
to as the defauit project.

These files are usually stored in the same directory as TC.EXE,
and are created if they are not found. When you run the IDE from
a directory without loading a project file, you get the desktop and
settings from these files. These files are updated when you change
any project-related options (for example, compiler options) or
when your desktop changes (for example, the window layout).

When you start a new project, the options you set in your
previous project will be in effect.
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IDE menus
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Table 2.8
IDE overview

The IDE is designed to explore and learn online. As you scroll the
menus, notice the status line explanation of each selection. When
you select an item, press F1 for online Help. The following table
has general information. The cross-reference table refers
individual menu entries to related information in the rest of the

- manual.

Menu

Use

File

Edit

Search .

Run

Compile
Debug

Project

Options

Window
Help

Repaint Desktop. Transfer to displayed programs. If you
don’t have the sample programs, add your own
standalone programs to the menu using the Options |
Transfer command.

Open and create program files in edit windows. Save -
changes, perform other file functions, and quit the IDE.

Cut, copy marked text to the Clipboard, and paste from
the Clipboard to the cursor position in an edit window.
Undo changes and even reverse the changes you've just
undone. The Edit | Copy Example command copies the
preselected example text in the current Help window to
the Clipboard.

Search for text, function declarations, and error locations
in your files.

Run your program or start and end debugging sessions.
Set arguments for the IDE to pass to the program as if
you entered them on the command line. For example, if
you would type progname args, enter args in the Run|
Argument dialog box.

Compile the currently selected module. Make (compiles
source files that have changed since the last compile then
links if necessary) or build (compiles and links all
modules, regardless of change) your current project.

Use the integrated debugger. See Chapter 6, “Debugging
in the new IDE.” Specify whether or not debugging
information is generated in the Options | Debugger dialog
box.

Control the features of the Project manager. See Chapter
7, “Managing multi-file projects”.

View and change various default settings in Turbo C++

including syntax Iughhghtmg

Manage windows.
Online help. Try F1, Alt F1, Sluft F1, and see Help on

: Help
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Syntax

highlighting

IDE cross-
reference

The edit window is syntax-sensitive, helping you see what the
code is doing. Use Options | Environment | Editor | Syntax
Highlighting to toggle the feature on and off. To choose the
colors, select Options | Environment | Colors | Edit Window..
Syntax items include Marked Text, Normal Text, Break Point
Line, Comment, Reserved, Identifier, Symbol, String, Integer,
Float, Octal, Hex, Character, Preprocessor, and Illegal Char.

Specific IDE menu items and dialog boxes relate to topics
discussed in other parts of this manual or in online Help. Table
2.9 helps you find them in the book. We capitalize each word in
the menu item to make them stand out. Switches refer to TCC
command-line options unless specifically defined as TC, MAKE,
TLINK, or TLIB. An asterisk ( * ) shows that the option is enabled
by default. Since the IDE has an integrated debugger, the -
standalone debugger command-line options are documented in
the manuals for that product.

Table 2.9: IDE menu cross-reference

Chapter 2, IDE basics

IDE menu selection Switch Page
File 36
Edit 36, 629
Search 36

Locate Function ... 240

- Run.

Run 36

Program Reset (Integrated debugger) 250

Go To Cursor 225

Trace Into 224

Step Over 224

Arguments ... 36, 250
Compile

Compile To OB]J —C 36, 286

Make TC /m 22,36

Build All TC /b 20, 36
Debug ’

Inspect 229

Evaluate/Modify 232

Call Stack

240

37



Table 2.9: IDE menu cross-reference (continued)

Watches
Add Watch...
Delete Watch
Edit Watch...
Remove All Watches
Toggle Breakpoint
Breakpoints...

Project

Open Project...

Add Item...

Delete Item

Local Options
Command Line Options
Output Path (for .OBJ file)
Project File Translators
Overlay This Module (with OILIS|OQutput| Overlald EXE)
Exclude Debug Information

Include Files... (compiled include files)

Options
Application
Standard*
Overlay
Library

Compiler
Code Generation

Model
Tiny
Small
Medium
Compact
Large
Huge

Options
Treat Enums As Ints*
Word Alignment

- Duplicate Strings Merged

Unsigned Characters
Precompiled Headers

Assume SS Equals DS
Default For Memory Model
Never
Always

Defines

Advanced Code Generation

Floating Point
None
Emulation*
8087
80287

38

237
237
239
239
239
228
- 227
253
253
253
267
254
259
TLINK /o 342, 587
TLINK /v- 344
257
-ms 273
-mm -Y 273,279
-ms 273
TLIB. UTIL.DOC
-mt 273
-ms 273
-mm 273
~mc¢ 273
-ml 273
-mh 273
-b 275
-a 275
-d 275
-K 277
-H 286, 635
273
589
273
274
274
—£- 276
~f 276
—£87 277
277

—£287
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Table 2.9: IDE menu cross-reference (continued)

Instruction Set
8088/8086
80186
80286
Options
Generate Underbars*
Line Numbers Debug Info
Debug Info In OBJs*
Fast Floating Point*
Fast Huge Pointers
Generate COMDEFS
Automatic Far Data
Far Data Threshold
Entry/Exit Code
Prolog/Epilog Code Generation
Standard*
Overlay
Calling Convention
C’(-
Pascal
Stack Options
Standard Stack Frame*
Test Stack Overflow
C++ Options
Use C++ Compiler
' CPP Extension*
C++ Always
C++ Virtual Tables
Smart*
Local
External
Public
Template Generation
Smart*
Global
External
" Options
Out-Of-Line Inline Functions*
Far Virtual Tables
-Optimization Options
Optimizations
Suppress Redundant Loads
Jump Optimization
Register Variables
None
Register Keyword
Automatic*
Optimize For
Size*
Speed
Source

Chapter 2, IDE basics

~1-
-1
-2

-u
-y

-V

—ff

-h

-Fc

~Ff
—Ff=size

Y-
-Y

_p -
P

-k
-N

—P-cpp

-V

~Vs
-Vo0
-V1

-Jg
—Jgd
—Jgx

-vi

-Vt

275
275
275

278
279
278
276
277
275
276
276

279, 589

278
278

278
278

286
286

287
288
288
288

290
290
290
279
288
280
280

280

280

280

280
279
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Table 2.9: IDE menu cross-reference (continued)

Keywords o
Turbo C++* . ~A-, -AT 281
ANSI -A 281
UNIX V ~ -AU 281
Kernighan & Ritchie ' -AK 281
Source Options '
Nested Comments -C 281
Identifier Length (32 by default) ~in 281
Messages
Display
Display Warnings
All -w 282
Selected , ~WXXX 282
None -w-
Errors: Stop After ’ —jn 282
Warnings: Stop After -gn 282
Portability
Non-portable Pointer Conversion* -wrpt
Non-portable Pointer Comparison* ‘ -wcept
Constant Out Of Range In Comparison* -wrng
Constant Is Long -wcln
Conversion May Lose Significant Digits —-wsig
Mixing Pointers To Signed And Unsigned Char ~wucp
ANSI violations
. Void Functions May Not Return A Value* ’ - —wvoi
Both Return And Return Of A Value Used* -wret
Suspicious Pointer Conversion* -wsus
Undefined Structure ‘ident™ o -wstu
Redefinition Of ‘ident” Is Not identical* -wdup
Hexadecimal Value More Than Three Digits* ~wbig
Bit Fields Must Be Signed Or Unsigned Int ~wbbf
‘ident’ Declared As Both External And Static* -wext
Declare ‘ident’ Prior To Use In Prototype* -wdpu
Division By Zero* -wzdi
. Initializing ‘ident” With ‘ident™ -wbei
Initialization Is Only Partially Bracketed ~wpin
C++ Warnings
Base Initialization Without A Class Name Is Obsolete* -wobi
Functions Containing ‘ident” Are Not Expanded Inline* ~—winl
Temporary Used To Initialize ‘ident™ -wlin
Temporary Used For Parameter ‘ident™ -wlve
Constant Member ‘ident’ Is Not Initialized* -wnci
This Style Of Function Definition Is Now Obsolete* - —wofp
Use Of Overload Is’ Now Unnecessary And Obsolete* -wovl
Assigning ‘type’ to ‘enumeration” -wbei
“Function1” Hides Virtual Function ‘Function2”* -whid
Non-const Function ‘ident’ Called For Const Object* -wncf
Base Class ‘ident’ Inaccessible Because Also In ‘ident’ -wibc
Overloaded Prefix Operator Used As Postfix Operator* ~wpre
Array Size For Delete Ignored* - -wdsz
Use Quahﬁed Name To Access Nested Type ‘ident™ -wnst
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Table 2.9: IDE menu cross-reference (continued)

Frequent Errors

Function Should Return A Value* : —wrvl
Unreachable Code* ' -wrch
Code Has No Effect* -weff
Possible Use Of ‘ident’ Before Definition* -wdef
‘ident’ Is Assigned A Value That Is Never Used* -waus
Parameter ‘ident’ Is Never Used* . - —wpar

~ Possibly Incorrect Assignment* . -wpia

Less Frequent Errors : '
Superfluous & With Function —wamp
Ambiguous Operators Need Parentheses -wamb
Structure Passed By Value -wstv
No declaration For Function ‘ident’ : -wnod
Call To Function With No Prototype ‘ ~Wpro
Unknown Assembler Instruction —wasm
Ml-formed Pragma* -will
Condition Is Always (True/False)* —wcee
Array Variable ‘ident’ Is Near* -wias
‘ident’ Declared But Never Used -wuse

Names .

- Code Segment -zC 284
Code Group ) -zP 285
Code Class -zA 284
Data Segment -zR 285
Data Group -z5 285
Data Class -zT : 285
BSS Segment —zD 284
BSS Group : -zG 285
BSS Class . ‘ -zB 284
Far Data Segment : -zE 284
Far Data Group ‘ , -zH 285
Far Data Class -zF 284

Transfer '
Program Titles
~GREP ) 259
Make i 297
Break Make On
All Sources Processed MAKE - 300
Check Auto-dependencies* MAKE -a 300
Linker '
Settings ‘ 331
Options
Initialize Segments TLINK /i 340
Default Libraries* TLINK /n 336, 342
Warn Duplicate Symbols TLINK /d 339
“No stack” Warning* : 335
Case-Sensitive Link* TLINK /¢ 338
Map file .
Off* TLINK /x 340
. Segments TLINK 340
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Table 2.9: IDE menu cross-reference (continued)

Publics
Detailed
Output
Standard EXE*
Overlaid EXE
Libraries
Container Class
Graphics Library
Standard Run Time*
Librarian
Options
Generate List File
Case-sensitive Library
Purge Comment Records
Create Extended Library
Library Page Size
Debugger
Source Debugging
On* -

Directories
Include Directories
Library Directories

Output Directory
Environment
. Preferences
Command Set
Editor
Syntax Highlighting (toggle on/off)
Startup
Video Startup Options
Dual Monitor Mode
Video Mode
Black & White / LCD
Swap File Drive
Use Extended Memory

Use EMS Memory*

Colors
Edit Window (Syntax Highlighting)

* enabled by default

TLINK /m 340

TLINK /s 340

TLINK /Td 332

TLINK /o 342, 589
CLASSLIB.DOC
607 :
Online Help

TLIB UTIL.DOC

TLIB /C -~ UTIL.DOC

TLIB /0 UTIL.DOC

TLIB /E UTIL.DOC

TLIB /Psize UTIL.DOC

-y 279
TLINK /v 344
—Ipath 293
. —Lpath 293
TLINK -Lpath 340
~npath 291
629
629
37
TC /d 21
TC /1 22
TC /r 22
TC /x 22

—Qx=nnnn 287

TLINK /yx 345
TC /e 21
—Qe 287
TLINK /ye 344
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An infroduction to C++

. Ifyouhavenever The best way to learn anything new is to start at the beginning. In
P rogfrqmmed inCorCt+,  the case of C++, which began as an extension to the C program-
his chapter is for you.
ming language, a knowledge of C is generally considered a
necessary starting point. This tutorial takes a somewhat different
approach, which makes it suitable for programmers and novice
programmers who want to learn C++ without first mastering C.
We can take this approach because, even though C++ supports a
radically different style of programming (known as object-oriented -
programming), the basic language elements are, with few
exceptions, the same as C. What C++ adds to Cis mostly a
number of high-level features to support this new programming
style. :
Ifyou are an experienced C  In this chapter you will develop a working knowledge of the
e oL Ty want g indamental language features of C++, many of which were
o scan this chapter briefly, . . ; .
then skip to Chapter 4, inherited from C. The program examples used here are designed
"Object-oriented  to illustrate the key concepts of C++ as clearly as possible. This
programming with C++.”  chapter is a necessary first step that will lead to an understanding
of the more complex and abstract principles of object-oriented
programming found in later chapters.

You will be introduced to a substantial body of new terminology
and concepts. There are sample programs that demonstrate how
these concepts are used. The best way to learn to program in any
language is to compile and run the sample programs. When you
understand how a particular sample program works, change it,
expand it, play with it.
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The sample programs are - You'll solve a variety of problems involving numbers, words, and
included in ﬂ;ﬁ:ﬁ"gﬁéﬁ graphics. We also provide some guidelines for de51gn1ng and

structuring programs.

How to run the examples

You can follow along with the examples in this chapter by
compiling and running the designated programs. To run the
example programs using the Turbo C++ IDE, follow these steps:

1. From the EXAMPLES subdirectory, start Turbo C++ by typing
TC. '

2. Open the example file you wish to compile by selecting File |
Open | example_file_name from the IDE menu.

3. Run the example program by selecting Run | Run.
4. To see the program’s output, select Window | User screen.

Alternatively, you may compile and run the examples from the
DOS command line. In the EXAMPLES directory, give the
command

TCC example file name <Enter>

After the example is compiled, you may run it and view the
output by typing

example_file_name <Enter> '

Bassic programming operations

Computer programs vary greatly in purpose, style, and complexi-
ty. Nearly all programs, however, go through a process consisting
of three phases:

m describing, collecting, and storing information (data)

m processing the data to achieve the desired result

m formatting, displaying and /or storing the results

Any data used by a program has to be described so that Turbo

C++ knows how to store and retrieve it. Memory must be set
aside to hold the amount of data expected. The program must
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To try out this program, load
and run INTRO1.CPP

(File | Open | INTRO1)., which
can be found in the
EXAMPLES subdirectory. For
more about how to load and
run the example programs
refer to chapter 2, "IDE
basics.”

then use some means to get the actual data into storage — this
could involve reading the characters from the keyboard,
retrieving data from a file on disk, receiving data over a telephone
line, or using some other kind of input device.

Once the data has been stored in numeric variables, character
strings, arrays, or more complicated data structures, it must be |
processed. The processing varies with the purpose of the pro-
gram, of course: A spreadsheet program might apply a formula to
a set of data to calculate a result, while a word-processing
program might rearrange lines of text to fit new margins.

- Once the data is processed, the results must be made available in

some way to the user. Lines of text can be rearranged on the
screen or sent to the printer, and the spreadsheet cells can be re-
displayed to show their new values. Most data must eventually be
stored on disk for later use. ’

Let’s use the three phases of program design in this short example
program. .

//INTRO1.CPP--Example from Chapter 3, "An Introduction to C++"
#include <iostream.h>

int main()
{
int  bushels;
float dollars, rate;
cout << "How many dollars did you get? $"-
cin >> dollars;
cout << "For how many bushels? ";-
cin >> bushels;
rate = dollars / bushels;
cout.precision(2);
cout << "You have received $" << rate << " for each bushel.\n";

return 0;

}
The first line of this program, //INTROL.CPP -- Example from
Chapter 3 " An Introduction to C++" is a comment. Comments are
preceeded by the // symbol and continue to the end of the line.
(Turbo C++ also recognizes the older C-style notation for
comments, which begin with /* and end with */. This style of
comments may include more than one line.) Comments are
ignored by the compiler. The comment symbol tells Turbo C++ to
ignore all characters from the // symbol to the end of the line. You
use comments to describe the purpose of a program, function, or
statement. Appropriate comments make it easier for you to
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Header files are also called
) include files.

Describing the data

remember just what a particﬁlar part of your program does —
and it helps other programmers who may later be called on to
modify your program.

The second line, #include <iostream.h>, tells the compiler to add
the Turbo C++ header file iostream.h to INTRO1.CPP before
compiling. jostream.h contains the declarations and functions for
the iostream input and output library. A library is a collection of
ready to use functions which your program can call to take care of
basic programming chores. We need iostream.h because it
contains the information which allows us to use the cout and cin
operators described below.

The next line, int main() defines a function. A function is a group
of related program instructions. Every C++ program must have a
main() function, which is where program execution begins.
Functions are the building blocks of C++ programs. The open
brace “{” indicates the beginning of a group of program
instructions, or statements—in this case, the statements which
define what will happen when the function main() is executed.
Each group of statements ends with a closing brace “}"”.

Notice that each statement ends in a semicolon (;). While Turbo
C++ lets you string several statements together on the same line,
we don’t recommend this; it makes programs harder to read.

The first two statements in INTRO1.CPP are

int  ‘bushels; »
float dollars, rate;

Recall that the first step in writing a program is “describing,
collecting, and storing information.” In C++, you must declare
each item of data before you can do anything else with it. To
declare an item of data, list what type of data it is, then give it a
name. Here, you have one data item that is of type int (integet, or
whole number), and is named bushels. You also have two data
items, dollars and rate, that are of type float (a floating-point
number is a numbér that has a decimal fraction). Notice that we
have declared two data items, dollars and rate, in the same
statement. You must separate the data items with a comma, and
the data items must be of the same type—in this case both are of
type float. These data items are also called variables, since their
value may be updated or changed as the program runs.

- Collecting and sforing the - The next four statements obtain and store the data we've just de-
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scribed. The cout statements prompt for the number of bushels
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and the number of dollars received for those bushels, and the cin
statements get these values and store them in the variables
named. Most of the actual work done in a Turbo C++ program is
accomplished by calling upon the functions provided in the
libraries included with Turbo C++. In this example our input and
output are handled by the iostream library. For now it is sufficient
to know that cout is the standard output stream (normally your
computer’s monitor screen), and cin is the standard input stream
(normally the keyboard). The operators << and >> are the
insertion (“put to”), and extraction (“get from”) operators.
Operators are symbols that tell the computer to perform some
type of basic operation on your data. The insertion and extraction
operators are members of an extensive set of operators provided
by Turbo C++.

We will discuss other operators later in this chapter.

Processing the data  The statement, rate = dollars/bushels, does the processing part of
the program, dividing the number of dollars by the number of
bushels to get the dollars per bushel.

Formatting the data  The statement, cout .precision(2),is a call to a member function
declared in iostream.h which formats our data for output.
cout.precision(2) is a special function which formats the way our
data will be displayed. cout.precision(2) affects all floating-point
input/output operations until its next use. For example, you
might want to display four decimal places at some other point in
the program, in which case you would use the statement
cout.precision(4). In INTRO1.CPP, cout.precision{2) specifies
that the floating-point numbers displayed by cout should be
rounded off to two decimal places, since we want to represent
dollars and cents. The cout operator defaults to six decimal places
if no provision is made to format the output. (Even though cout
defaults to six decimal places for floating point numbers, it will
automatically drop any trailing zeros).

Displaying the data  The final statement,
cout << "You have received $ " << rate << " for each bushel\n";

once again uses cout to display the results of this calculation. The
first << (insertion) operator directs the output of the phrase “You
have received “ to the screen. The monitor screen is the default
output device of the cout operator. The second << operator ‘
outputs the value of the variable rate, and the third << operator .
directs the phrase “ dollars for each bushel” to the screen. The \n
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is the newline symbol which places the cursor at the beginning of
the next line.

When you run the program, the output looks like this:

How many dollars did you get? $32
For how many bushels? 24 )
You have received $1.33 for each bushel

Basic structure of a C++ progrdm

This next example demonstrates functions, variables, and the
preprocessor directive #include.

Load and run INTROZ.CPP. // INTRO2.CPP--Example from Chapter 3, "An Introduction to C++"
// INTRO2.CPP calculates a sales slip.

#include <iostream.h>
float tax (float);

int main()
{ .
float purchase, tax_ amt, total;
cout << "\nAmount of purchase: ";
cin >> purchase;

tax_amt = tax(purchase);

total = purchase + tax_amt;
cout.precision(2);

cout << "\nPurchase is: " << purchase;
cout << "\nTax: " << tax_amt;

cout << "\nTotal: " << total;

return 0;

}

float tax (float amount)
{
float rate = 0.065;
return{amount * rate);

}

The first and second line of the program are comments. Line three
is a preprocessor directive which tells Turbo C++ to read in and
compile the contents of the header file iostream.h.

'

The general formatof @ The next statement is a function declaration, it declares or describes
function decggrzot%i the user-defined function float tax(float). Function declarations,
function_name(parameter_type - also called prototypes, give the compiler important information

(parameter_name) ...); - about the function so it can recognize and use it in the program.
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The first word of the function declaration, float, specifies that this
function will return a value of type float (a floating-point number).
When we say that a function will return a value, we mean that the
function will pass its-answer back to the program when it has
finished its work. The word tax tells the compiler the name of the
function, and the word in parentheses (float) tell the compiler
that this function will expect a floating point number as input.
Inputs to a function ar